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Teach Yourself Word 2007 (Level 1) 

This book is designed to teach beginner topics for learning Microsoft Word 2007.  It contains
simple step-by-step exercises to guide you through the learning process. 

There are dozens of exercises including consolidation exercises, both theory and practical at
the end of each section. 

An assignment is included in the Appendix which revises all topics learnt. 

The process of consolidation and accumulation of learning is unique to the Cheryl Price
books. 

Retrievable exercise files are used with this book.  These will be sent to you in the form of a zipped
file.  Instructions for unzipping the file are included on the next page. 

©  cherylprice.co.nz, November 2009 

Author: 

Cheryl Price   
T.Dip.WP,  T.Dip.T  

Disclaimer 

All rights reserved.  This publication may be photocopied by the owner or license holder of this product.  

No patent liability is assumed with respect to the use of the information contained herein.   

While every precaution has been taken in the preparation of this book, the owner and author assume no 
responsibility for errors or omissions.   

Neither is any liability assumed for damages resulting from the use of the information contained herein. 
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Matakana 

Web address: 
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Downloading Exercise Files 

Exercise files can be downloaded from the Cheryl Price web site as follows: 

1 In your web browser, type: www.cherylprice.co.nz 

2 Press Enter on the keyboard to display the Cheryl Price website. 

3 Click on the Resources tab as shown at the right. 

4 Click on  Easy Way – Microsoft Word 2007   

5 

Click on the Free download hyperlink, ie  

Word 2007, Level 1   Free download  

The File Download dialog box will display.   

6 If you have Winzip use the following instructions otherwise move to step 7. 

a   Click on  .    

b   Click on the  of the  button. 

c  If My Documents folder is not displayed click on Set default unzip folder at the bottom of
the list.  Ensure My Documents is selected then click on Select Folder . 

d    Click on the  of the  button and click on the My Documents folder.  The files will
be unzipped. 

7 Click on and ensure My Documents folder is displayed.  Click on  

8 

Click on Open Folder which will display My Documents folder.  Right click on the zipped
exercise file and select Extract All. Click on Extract.  A folder will be created containing the
exercise files.   

You will need to double click on this folder to use the exercise files in this book. Sa
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What is Microsoft Word? 

Microsoft Word is a word processing program that allows you to create text and/or graphics using 
a keyboard which is displayed on screen (referred to as “soft copy).  The document is then saved 
onto the hard disk in your computer system.  A document can be opened on screen and edited and 
formatted (as many times as necessary).  A “hard copy” can be produced by sending the 
document to the printer. 

A word processing program generally includes the creation of - 

 General correspondence, eg letters, memos, faxes 
 Reports, travel documents, Minutes of meetings, financial documents  
 Advertisements, flyers, brochures 
 Mail merges (ie direct mail), labels, tables 
 Manuals, other documentation 
 

The Process of a Word Processed Document 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  
Final copy is printed 

(hard copy) 
 

Document is opened on screen.  It can 
then be edited and formatted, saved 

and resaved as many times  
as necessary. 

Document is printed 
(hard copy) 

 

  
23  January 2010 
 
Mr R B Jacobs 
45 Elm Lane 
OREWA 
 
Dear Mr Jacobs 
 
As requested I am enclosing information on 
Elf Computer Systems.   
 
Please let me know if I can be of further 
assistance. 
 
Yours sincerely 
 
 
Sam Corinaldo 
Manager 
 
Encs 

Document is saved onto the 
Hard Disk inside the  

System Unit 

Text is displayed on monitor 
(soft copy) 

Text is copied from paper 
(or keyed in directly via the 

keyboard onto the  
computer monitor) 

 

  
23  January 2010 
 
Mr R B Jacobs 
45 Elm Lane 
OREWA 
 
Dear Mr Jacobs 
 
Thank you for your letter of 15 December 2009.  
I aI am enclosing information as requested by 
you in your email.  Please ddo not hesitate to 
contact me. 
 
Yours sincerely 
 
 
 
Sam Corinaldo 
Manager 
 
Encs 

 
 
 

 

System Unit 
Monitor 

Keyboard Mouse Speakers 

 Dk kfj k kdj kadj kd kadj fkad 
jkdj akljd jasd kaj kadj kadj kdj 
fkdjf kadj kadj kasdj lkasdj 
klasdj lkasdj lksdj fkasdj klsdj 
fksdj flksdj flkasdjf lksdj fkasdj 
fklasdj klasdj lkasdj lkadjf kadjf 
ak; 

  
23  January 2010 
 
Mr R B Jacobs 
45 Elm Lane 
OREWA 
 
Dear Mr Jacobs 
 
Thank you for your letter of 15 December 2009.  
I aI am enclosing information as requested by 
you in your email.  Please ddo not hesitate to 
contact me. 
 
Yours sincerely 
 
 
 
Sam Corinaldo 
Manager 
 
Encs 

 Dk kfj k kdj kadj kd kadj fkad 
jkdj akljd jasd kaj kadj kadj kdj 
fkdjf kadj kadj kasdj lkasdj 
klasdj lkasdj lksdj fkasdj klsdj 
fksdj flksdj flkasdjf lksdj fkasdj 
fklasdj klasdj lkasdj lkadjf kadjf 
ak; 
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Default Settings 

Microsoft Word 2007 contains settings that need to be changed when using this book.  “Default 
settings” is the term used for formats that apply to every document that is created. 

In Microsoft Word a “template” is attached to every document which sits behind the document 
and contains the default settings.  The template that is attached to all documents is called the 
Normal Template. 

The following diagram is a simplistic illustration: 

 

 

 

 

 

 

 

 

 
 
 
If you know how to start Word 2007 you can change the following defaults (you can use the 
instructions from Section 1, page 2).  If not, wait until you have finished Section 1 and are 
familiar with the Word 2007 screen. 
 

Font and Font Size  

1 Click on the diagonal arrow at the right of Font on the Ribbon . 
 

2 Click on the Font  (or drag the scroll box) until you see 
Times New Roman then click on this font. 
 

3 Click on the Size  and select 12. 
 

4 Click on  

The dialog box shown below will be displayed: 

 

5 Click on Yes.  
  

Template 
 

Includes settings, eg 
 

Font Formatting: 
 Font 
 Font size 

Paragraph Formatting: 
 Line spacing 
 Spacing Before 
 Spacing After 
 Tab settings 

Page Layout 
 Paper Size 
 Margins 
 Orientation 
 

 

Document 
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Paragraph Formats 
 

1 Click on the diagonal arrow at the right of Paragraph on the 
Ribbon - . 
 

2 Ensure that settings are displayed as shown at the right, ie 
 

Alignment:  Left 
 

Indentation:  0 cm Left and Right. 
 

Spacing Before and After:  0 pt 
 

Line spacing:  Single 
 

3 Click on  
 
The dialog box shown below will be displayed: 
 

 
 

4 Click on Yes. 
 

 

Page Layout 
 

1 Click on the Page Layout tab at the top of the screen. 
 

2 Click on the diagonal arrow at the right of Page Setup on the Ribbon - 
. 

 

3 Ensure that settings are displayed as shown at the right, ie  
 

Margins, Top, Bottom, Left, Right:  2.54 cm 
 

Orientation:  Portrait 
 

4 Click on the Paper tab at the top of the dialog box. 
 

5 Ensure that settings are displayed as shown at the right, ie 
 

Paper size:  A4 
 

Width:  21 cm 
 

Height:  29.7 cm 
 

6 Click on  
 

7 The dialog box shown below will be displayed: 
 

 
 

8 Click on Yes. 
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Word Processing Terminology 
 

Bold Emphasises the text, ie it is darker. 

Bullets Symbols used at the beginning of selected paragraphs to itemise those 
paragraphs. 

Centring The term centring is given to text that is centred between the left and right 
margins (ie horizontal centring) or between the top and bottom margins (ie 
vertical centring). 

Clipboard The place where text is temporarily stored when it is cut or copied – and can 
then be pasted, ie inserted in another location, or another document. 

Close   When you have finished with a document, ie have typed, saved and/or printed, 
you must close the document, ie remove it from the screen. 

Copy and 
Paste 

Text is copied to the Clipboard for pasting to another location, or document. 

Cut and Paste The term given by Microsoft Windows for “move”.  Text is cut to the 
Clipboard for pasting to another location, or document. 

Creating a 
document 

The term given to when you start a new document for typing in text, or for 
pasting text from another document. 

Default 
Settings 

The settings that occur in every new file you create, eg the font may be Times 
New Roman 12 pt, paper size will be A4 etc. 

Deleting The term given to removing text (which can be selected) from your document. 

Dialog Box When you select a command in Microsoft Word, eg to Save, a dialog box will 
appear on screen for you to choose options. 

Folder Just like a folder in a filing cabinet, a folder on a computer allows you to 
store/save files. 

Document The term given to a word processing file, eg a letter, memo, fax etc. 

Edit To make alterations to your document, eg delete text, move text etc. 

File name When a document is saved a file name must be assigned to that file to identify 
it from other documents, eg for opening, printing etc. 

Font A font is a style of type.   

Font Size The font size refers to how large or small the font appears, eg 18 pt font size is 
larger than 16 pt. 

Formatting The term given to changing the document, ie text formatting (font, font size, 
bold, italics etc.); paragraph formatting (indents, tabs, line spacing etc.); page 
formatting (margins, paper size, page numbers etc.) 

Header/footer Text that appears on every page of your document (a header is at the top of the 
page and  a footer is at the bottom of the page). 
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Keyboard 
Shortcut 

The term given to “quick keys”, eg the Keyboard Shortcut for Bold is Ctrl B, 
Italics is Ctrl I etc. 

Margins The areas of white space and the top, bottom, left and right edges of your 
document. 

Menu A list of choices, eg the Shortcut Menu displays various options. 

Open When a document is opened it is displayed on screen – usually for editing or 
formatting. 

Page 
Formatting 

Refers to the layout of the document on the page, eg margins, paper size, 
orientation, vertical centring etc. 

Page 
Numbering 

Numbers are inserted into a header or footer to appear automatically on every 
page.  When text is edited the page numbers will adjust. 

Paragraph 
Formatting 

Refers to the formatting of a paragraph, or selected paragraphs, eg alignment, 
indents, tabs, line spacing, bullets and numbering etc. 

Pasting When text is cut or copied to the Clipboard it can then be pasted, ie inserted in 
another location, or another document. 

Previewing A document can be Print Previewed prior to printing to check that all 
formatting and page breaks are correct. 

Printing When a document is printed it is sent to the printer to produce a hard copy. 

Redo Redo reverses the procedure you have used with the Undo button, eg if you 
have deleted text then clicked on the Undo button you can then use the Redo 
button to restore the text again. 

Save The term given to the process of filing/storing the document on your computer 
system. 

Selecting The term given to the process of defining, or highlighting text so you can 
perform another action, eg to copy, cut, change the font and/or font size etc. 

Shortcut 
Menu 

When you right click in Microsoft Word the Shortcut Menu will be displayed 
which allows you to select from options. 

Status Bar A line of information at the bottom left of the Word screen.  It shows the page 
number, number of pages, number of words and dictionary used. 

Text 
Formatting 

Refers to changing the appearance of selected text, eg font, size, colour, bold, 
underlining, italics etc. 

Toggle Toggle refers to when a keystroke is used to turn a feature on and also to turn 
it off, eg Ctrl B. 

Undo The Undo feature is used to reverse an action, eg if you had deleted text and 
then wanted it back in the document you would click on the Undo button. 

Zoom Zoom refers to the magnification of the document, ie you can zoom in to 
increase, or zoom out to decrease. 
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 The Word 2007 Screen 

Create, Save, Open and Print Documents 

 Cursor Movements 

 Zoom and Document Views 

 

 

Learning Outcomes 
 
At the end of this section you should be able to -  
 
 

 Start and exit Word 2007 

 Identify parts of the Word 2007 screen 

 Understand the Ribbon and groups 

 Create, save, open, print and close documents 

 Practise cursor movements 

 Use the Zoom feature and Document View options 

 Minimize, Restore Down and Maximize a document  
 
 
 
 
 
 
 
 
 
 
 

Section 1 
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Starting Microsoft Word 

Exercise 1 

1 Click on  in the bottom left corner of your screen. 

2 Move the mouse pointer onto All Programs then across to Microsoft Office. 

3 Move the mouse pointer across and down to Microsoft Office Word 2007 and click. 
 
Microsoft Word will be displayed on screen with a new document, ready for you to enter text. 
 
 
 

 
 
 

You can move the mouse pointer to various parts of the screen to see a description of that part. 
 

The Office Button 

The Office Button  at the top left of the Microsoft 
Word screen is used to save, open, print and close 
documents.  When you move the mouse pointer up to the 
Office Button the description at the right will be displayed. 
 
Exercise 2 

1 Move the mouse pointer onto the Office Button. 
2 Read the information displayed. 
3 Move the mouse pointer away from the Office Button description. 

4 Now look at the description of Help  then Format Painter  (under the Office Button, in the 
Clipboard group). 

Microsoft Office 
Word 2007 appears 
on the Start menu 
after you have used 
it three times.  You 
can click on it to 
start Word. 

Ribbon 

Status Bar 
Insertion point Rulers 

Esc 

 

 
 

Start Button 

Help 

Taskbar 

 
 

Zoom Controls 

Close 
Quick Access Toolbar 

Vertical Scroll Bar 

Vertical Scroll Box 

Select 
Browse 
Object 

Title Bar 

Office Button 
Minimize Restore Down 

Status Bar Taskbar Start Button 

Insertion point Rulers 

 

Group 

 

Tabs 

View Ruler 

Note:   

If Rulers are not 
displayed click on the 

View Ruler button at 
the top of the Vertical 
Scroll Bar. 

 

Document Views 
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The Ribbon 

The Ribbon is a new feature in Microsoft Word 2007 and replaces menus and toolbars that were used 
in previous versions of this program.  It is divided into groups and used as follows:   
 
(a) When you click on a tab, groups will be displayed relating to that particular feature, eg the Home 

tab displays the groups shown below, ie Clipboard, Font, Paragraph, Styles, Editing. 
 
 

 
 
 

(b) Clicking on a down arrow  displays options for that feature, eg clicking on 
the down arrow at the right of Underline  in the Font group displays 
underlining options as shown at the right.  

(c) Clicking on  to the right of the group name displays the relevant dialog box, 
from which you can also select the same, and additional options, eg clicking 
on the Font  displays the dialog box for that group as shown below.  (Click 
on Cancel to remove the dialog box.) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Exercise 3 

1 Click on the Page Layout tab. 

2 In the Page Setup group click on the Orientation down arrow . 

3 Write down the two options that are displayed ...............................................................................  

4 Click to remove options. 

5 Click on the Page Setup  which displays  ...................................................................................  
(You will notice there is an Orientation section with the same options as the  
button in the Page Setup group on the Ribbon.) 

6 Click on Cancel. 

7 Click on the Home tab. 

Groups 

 

Tabs 

 

 
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Exercise 4 
 

1 Type the text shown below onto your screen using the following instructions: 

a To type the heading in uppercase press the Caps Lock key.  Type ONLINE AUCTIONS 
then press the Caps Lock key to turn off uppercase typing. 

b Press Enter twice to insert a blank line. 

c For an initial uppercase letter, eg the A of An, hold down the Shift key on the opposite side 
of the keyboard to the letter you are going to type, ie hold down the right Shift key, type A 
then release the Shift key.  Continue typing the remainder of the word. 

(The Shift key is also used to type the top symbols on the keys showing two symbols.) 

d Type the remaining text.  Leave any typing errors – you will correct these in Exercise 8. 
Do not press Enter at the end of each line as the text will automatically wrap to the next 
line.  (Enter is pressed once for a new line or twice for a new paragraph.) 

 
 

ONLINE AUCTIONS 
 

An online auction business is a web site where participants bid for products and 
services over the Internet. The process of buying and selling in an auction format is 
made possible through auction software which regulates the various processes 
involved. 
 
 

 

Saving a document 

Every document you create must be saved with a unique name (called the “file name”) so you can 
recall it to the screen for editing, formatting or printing at a later time.  (Keep file names simple and 
relevant to the document.  You can use letters and numbers, hyphen and underscore.) 
 
Exercise 5 

1 On the Quick Access Toolbar  at the top left of your screen click on the Save 

button .  

The heading becomes the file name for your document, ie ONLINE AUCTIONS (OR you can 
type another file name on top of the given file name).   

2 Click on .  The file name is now displayed at the top of the screen, ie ONLINE 
AUCTIONS – Microsoft Word. 

 
Closing a document 

When you have finished with a document you need to close 
it.  If you haven’t saved any changes, you will be prompted 
to do so (as shown at the right). 
 
Exercise 6 

1 Click on the Office Button. 

2 Click on  
 
 

Ctrl S 

 

 
 

You can click on 
the Office Button 
then click on Save. 

 
 

Ctrl W 

 
 

The Quick Access 
Toolbar may be 
displayed under 
the Ribbon. 
 

 
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Creating a new document 

When you first enter Microsoft Word a blank document automatically appears on screen.  When this 
document is closed you will need to create each new document from then on. 

In the following exercise you will correct basic spelling and grammatical errors. 
 
Exercise 7 

1 Click on the Office Button. 

2 Click on .  Blank Document is already selected in the New Document dialog box. 

3 Click on . 

4 Type the following text carefully, and exactly as shown below.   

Notice when you type The that it is corrected automatically. 

You will correct errors in steps 5-10 underneath. 

 
 

WHAT IS A TRIATHLON? 
 

A triathlon is an athlettick event that includes swimming, running, and cycling. Teh 
triathlete therefore must frocus his or her training on all three parts. There is 
actually five different lengths of triathlons; they range from short and doable to 
crazy long. (Press Enter)   

 

5 Position the mouse pointer in the middle of the word athlettick and click 
the right mouse button (referred to as “right clicking”), which displays the 
Shortcut Menu.  Click on the first option. 

6 Right click on frocus and select the correct option. 

7 Notice that Teh has been corrected automatically.  

8 Right click on triathlete then click on Add to Dictionary.  (Future occurrences of that word will 
not be displayed as errors). 

9 Correct any other errors you may have made. 

10 Correct There is by right clicking on is and selecting the correct option, ie are  (The wiggly 
green line under is was not displayed until you pressed Enter at the end of the paragraph.) 

11 Save the document with the file name Triathlon  (In the Save dialog box simply type the file 
name Triathlon over the text displayed in the File name: box, ie WHAT IS A TRIATHLON? 
then click on Save).   

12 Close the document. 

Opening a document 

A document is “opened” when you need to recall it to the screen, eg 
for editing.  
 
Exercise 8 

1 Click on the Office Button. A list of Recent Documents is displayed at the right.   

2 Click on the file name of the document required, ie ONLINE AUCTIONS.   

(If the required document is not displayed on the Recent Documents list click on .  
Click on the file name of the document required then click on ). 

Ctrl N 

 

Ctrl O 

 

You can double 
click on Blank 
Document 

 

 
 

 
 

You can double 
click on a docu-
ment to open it. 
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3 Click at the end of the document and press Enter twice to start a new paragraph. 

4 Correct any errors you may have made then type the following: 
 

The most common online auction web site in Australia is EBay and in New Zealand it is 
TradeMe. 

 

5 Click on the Save button on the Quick Access Toolbar to save and replace the document. 
 

Quick Print 

The Quick Print option sends the document directly to the 
default printer. 
 
Exercise 9 

1 Click on the Office Button. 

2 Move the mouse pointer down to then across to Quick Print. 

3 Click on Quick Print.  The document will be sent to the printer. 

4 Close the document. 
 

 
Zoom 

You can zoom in to get a close-up view of your document or zoom out to see more of the page at a 
reduced size.  The Zoom Controls on the Status Bar are located at the bottom right of your screen.   
 
 
 
 
 
You will notice that the Zoom Slider is in the middle of the bar, ie at 100% view.   
 

The Zoom Controls are used as follows: 

(a) Drag the Zoom Slider to the left to reduce the size of your document. 
(b) Drag the Zoom Slider to the right to enlarge the size of your document.   
OR 
(a) Click on the Zoom Out button to reduce by increments of 10%.  
(b) Click on the Zoom In button to enlarge by increments of 10%. 
 

Exercise 10 

1 Open the document called Africa 
2 Drag the Zoom Slider to the left, to the middle, to the right and then back to the middle (ie 

100%) 
3 Click on the Zoom Out button three times to zoom to 70%. 
4 Click on the Zoom In button three times back to 100% then another three times to 130%. 
5 Change to 100% view.   
6 Click on the View tab, then click on Two Pages, One Page, Page 

Width, then 100%. 
7 Leave your document on screen for the next exercise. 

Percentage Indicator Zoom 
Out 

Zoom 
In 

Zoom 
Slider 

 
 

Clicking on the 
Percentage 
Indicator opens the 
Zoom dialog box 
 
 

 
 

Ctrl End 

 

Ctrl S 
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Cursor Movements 

The mouse pointer shows as follows on the Microsoft Word screen. 

I  The mouse pointer is displayed as an insertion point, sometimes called an I-Beam when it 
is within text.  You can move the insertion point to the location required, then click the 
left mouse button to set the cursor at that position.   

 
The pointer changes to a left pointing arrow when it is moved to the scroll bars, Status 
Bar, or to the top part of the screen. 

 

The table below shows quick cursor movements for both the mouse and keyboard shortcuts. 
 

Cursor Position Mouse Keyboard Shortcut 

A character at a time Move mouse and click Right  or Left  

A word at a time Move mouse and click Ctrl  or Ctrl  

Beginning of line Move mouse and click Home 

End of line Move mouse and click End 

A line at a time Move mouse and click Up or Down  

Down one paragraph Move mouse and click Ctrl  

Up one paragraph Move mouse and click Ctrl  

Bottom of current window Move mouse and click Alt Ctrl Page Down 

Top of current window Move mouse and click Alt Ctrl Page Up 

Down one window Click below Vertical Scroll Box Page Down key 

Up one window Click above Vertical Scroll Box Page Up key 

Down one page *  Click on  at bottom right of screen  Ctrl Page Down 

Up one page *  Click on  at bottom right of screen  Ctrl Page Up 

Beginning of document 
#  Drag the Vertical Scroll box to the top of the 

Vertical Scroll Bar and click  
Ctrl Home 

End of document 
#  Drag the Vertical Scroll box to the bottom of 

the Vertical Scroll Bar and click  
Ctrl End 

 

Go To 

The Go To feature allows you to move to a specific page (or other location) in your document.  
Simply press Ctrl G, enter the page number then click on Go To.  Click on Close. 
 
*  Select Browse Object   

 If you cannot move up or down a page at a time click on the Select Browse Object button  at 

the bottom right corner of the Microsoft Word screen and select the Page option .  When you 
click on the  (Next Page) and  (Previous Page) buttons you will then be able to move a page 
at a time through your document. 

 
#  Vertical Scroll Box 

 The Vertical Scroll Box can be dragged up or down on the Vertical Scroll Bar to 
display a page indicator.  When you release the mouse button the page shown 
will be displayed. 

 * See below  

# See below   
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Status Bar 

The Status Bar at the bottom left of the screen displays 
information about the document on screen, ie the page 
you are on, the number of pages, number of words and the dictionary used. 
 
Exercise 11 

1 With the document called Africa on screen practise moving the cursor around the document, 
using both mouse and keyboard shortcuts shown on the previous page. 

2 Which is the quickest way to move the cursor - 

 to the end of a document ................................................................................................................  

 to the end of a line ..........................................................................................................................  

 to page 3 .........................................................................................................................................  

3 The Status Bar shows the following information: ..........................................................................  

4 Close the document. 

 
Saving changes to the document on screen and retaining the 
original document 

Sometimes when you make editing and/or formatting changes you will want to retain your original 
document and save the edited document with a new file name.   
 
Exercise 12 

1 Open the file called Triathlon 

2 Press Ctrl End. 

3 Press Enter twice then type the following:  (You will notice that triathlete is not shown as a 
spelling error because you added it to the dictionary in Exercise 7). 

 

Training requirements increase as the triathlete works his or her way up the 
fitness chain. A sprint version requires the athlete to swim 750 metres, bike 20 
km and run 5 km.  You can then proceed to do a Half Iron Man if desired. 

4 Click on the Office Button. 

5 Click on  

6 In the File name: box, on top of the existing file name, type a new name for your document, ie 
Training Requirements. 

7 Click on  so the changes made are saved to the new document only.  (The original 
document is therefore retained on file.) 

8 Zoom to 75%. 

9 View your document as Page Width (use the View tab). 

10 View your document 100%. 

11 Quick print the document and close. 

12 Open the document called Triathlon and you will see that the original document has been 
retained.  (The changes made have only been saved in the Training Requirements document.) 

13 Leave your document on screen for the next exercise. 

F12 

 

 
 

 
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Minimize, Restore Down and Maximize 

 Clicking on the Minimize button  at the top right of the screen reduces a window to a button 
on the Taskbar. 

 Clicking on the Restore Down button  at the top right of the screen reduces the size of the 
current window.  The Restore Down button will then display as the Maximize button . 
 

 Clicking on the Maximize button  makes the window full screen again. 
 

 
Exercise 13 

1 Click on the Minimize button  at the top right of the screen. 

The window will be minimized and reduced to a button on the Taskbar at the bottom of the 
screen . 

2 To bring the document back to full screen click on the icon displayed on the Taskbar, ie 
. 

3 Click on the Restore Down button  at the top right of the screen.   
(The Restore Down button is now replaced with the Maximize button.) 

 

The size of the window may vary to that shown above.  It can be resized by moving the mouse 
pointer to outside edges of the window (and corners) then dragging outwards or inwards (see the 
arrow at the top right corner above. 

4 Click on the Maximize button  to make the window full screen again. 
 

 
Closing a document without saving changes 
If you have not saved changes when you close a document, you will be requested to do so.  If you 
click on No then only the original document will be retained. 
 

1 Click at the end of the document, press Enter then type your 
name. 
 

2 Click on the Office Button then click on Close.   
 

3 Click on No.  (The changes will not have been saved.) 
 

  

 
 

If you have more 
than one document 
open, you can 
switch from one 
document to 
another by clicking 
on the document 
icon on the 
Taskbar. 
 

Ctrl W 

 

Resize arrow 
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Document Views 

Microsoft Word 2007 has five different view options.  These are available by using the Document 
View buttons at the bottom right of your screen as shown at the left below, OR, you can click on the 
View tab which displays the same view buttons in the Document Views group as shown at the right. 
 

 

 

 
Exercise 14 

1 Open the document called Africa. 
2 Use this document to look at the views described below and on the next two pages. 

Print Layout  

Print Layout is the default view and shows the document as it will be printed.  Graphics, tables, 
columns, illustrations page numbers etc are displayed and can be edited. 

 

Full Screen Reading  

Full Screen Reading displays the document in a side-by-side format, designed for easier reading. 

 

Print Layout 

Full Screen 
Reading 

Web 
Layout 

Outline 
Draft 

Alt Ctrl P 
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If you click on  at the top right of the screen you can increase the text size, show one 
page, show the page(s) as they will be printed, allow typing while reading etc.  Other options are 
available on the toolbar at the top left of the screen, eg printing, highlighting text, adding comments. 

You can move through pages of the document by clicking on  at the bottom right corner. 

To exit from Full Screen Reading, click on  at the top right of the window. 
 

Web Layout  

Web Layout displays the document (text and graphics) as it would appear as a web page on the 
Internet or on an Intranet. 

 

 

Outline  

Outline view displays document headings which have been formatted using heading styles (a more 
advanced feature of Microsoft Word).  Special options are available on the Ribbon to expand/collapse 
text and/or headings. 

 

Alt Ctrl O 
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Draft  

Draft view (referred to as Normal view in previous versions of Word) displays text only and page 
breaks, column breaks etc.  Graphics, illustrations, page numbers etc are not displayed.  You can 
move the Zoom Slider  at the bottom right of the screen to make the text larger (or smaller). 

 
 

Exercise 15 

(You may need to refer to pages 9-12 for this exercise) 

1 Ensure the document called Africa is displayed on screen. 

2 Which view was displayed when the document was opened?   ....................................................  

3 Switch to Full Screen Reading  and try out the options displayed on the  
button at the top right of the screen. 

4 Close Full Screen Reading view. 

5 Which view is now displayed?   ...................................................................................................  

6 Switch to Web Layout view . 

7 Have you noticed anything different to Print Layout view? .........................................................  

 ......................................................................................................................................................  

8 Switch to Outline view .  What does this view display? .........................................................  

 ......................................................................................................................................................  

9 Switch to Draft view  and drag the Zoom Slider  (at the bottom right of your screen) to the 
right to enlarge the text.  

10 Switch back to Print Layout view  then close the document without saving. 

Exiting Microsoft Word 

When you have finished using Microsoft Word you must exit from the program.  If you haven’t 
closed documents you will be prompted to do so. 
 
Exercise 16 
 

1 Click on the Office Button. 
 

2 Click on . 

You can click on 
the Close button 

 at the top 
right of the 
screen. 
 

Alt F4 

 
 

 

 
 

Alt Ctrl N 
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Consolidation Exercises 

In addition to completing the following exercise you are also required to write the keyboard shortcut 
for that feature on the dotted lines in the margin. 
 
Exercise 17 

1 Start Microsoft Word. 

2 Under the following diagram write next to the relevant number, the name and purpose of the 
various parts of the Microsoft Word screen that you have learnt in this lesson: 

 

 
 

Name  Purpose 

  .....................................................    .................................................................................  

  .....................................................   .................................................................................  

  .....................................................    .................................................................................  

  .....................................................   .................................................................................  

  .....................................................    .................................................................................  

  .....................................................   .................................................................................  

  .....................................................    .................................................................................  

  .....................................................   .................................................................................  

  .....................................................    .................................................................................  

  .....................................................   .................................................................................  

  .....................................................   .................................................................................  
  

 

 
 

     

 

 

 

 

 
 

11 

11 
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3 What is the name of the following section of the Word screen?  .................................................  

4 In the boxes below, write in the relevant names given to these areas. 
 

 

 

 
 

 

 

5 Explain what the following symbols are used for: 

A down arrow at the right of a feature  ................................................................................  

  ................................................................................................................................................  
 

6 The following section of the Word screen is called ...................................................................... . 

 

 
 

7 Write the name and purpose of the parts indicated. 

Name  Purpose 

  .....................................................    .................................................................................  

  .....................................................   .................................................................................  

  .....................................................    .................................................................................  

  .....................................................   .................................................................................  

8 The name of this Document View button  is  .......................................... and it is used to   

 ......................................................................................................................................................  
 

Exercise 18 

1 Type the following exactly, using the Shortcut Menu to correct spelling and grammatical errors. 

 
CHOCOLATE 
 

Many people has a real passion for chocolate. 
 

The scret to choosing good chocolate is in carefully reading the 

information on the label.  Ideally chocolate should contain nothing more 

than cocao paste, cane sugar, cocoa butter and maybe a little cream and 

vanilla. 
 

2 Save the document with the heading as the file name. 

3 Close the document. 
 

……… 
 ……… 
 

 
 
   

 
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Exercise 19 

1 Open the document called CHOCOLATE 

2 Go to the end of the document and start a new paragraph. 

3 Type the following exactly as shown.  

 

To much sugar and a low cocoa content meens that any chocolate 

flavour will be masked by sweetness. (Press Enter) 

 

4 Correct spelling and grammatical errors. 

5 Save the document with the file name as Chocolate Ingredients 

6 Explain the difference between Save and Save As. 

 ......................................................................................................................................................  

 ......................................................................................................................................................  

7 Change the Zoom Slider to display 84% view then 164%. 

8 Using the View tab change to Page Width. 

9 Change to 100% view. 

10 How would you move the cursor – 

to the beginning of a line  .............................................................................................................  

to the beginning of the document  ................................................................................................  

down one page, in a multi-page document  ..................................................................................  

11 Write down the information displayed on the Status Bar  ............................................................  

12 Minimize the document. 

13 Expand the document to full screen. 

14 Use the Restore Down button to view the document in a smaller window. 

15 Maximize the document. 

16 Print the document. 

17 Close the document. 
 

Exercise 20 

1 Open the document called Scuba Diving 

2 Display the document in different views, ie Full Screen Reading, Web Layout, Outline, Draft 
and then Print Layout. 

3 Press Enter at the end of the document and type your phone number. 

4 Close the document without saving. 

5 Exit from Microsoft Word. 

 Did you remember to write the shortcut keys in the margin where indicated by dotted lines? 

……… 
 ……… 
 

……… 
 

……… 
 

 
 

 
 

……… 
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